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Introduction

The real power of Excel lies in integrating isolated concepts. For 

instance creating a dynamic chart by integrating formulas with named 

ranges.. that’s super fun!

This book is divided into 9 parts that talk about various advanced 

concepts and explain how to integrate them with one another

I have tried to write this book like a dialogue to make it fun filled and 

humorous while the technical alchemy is at play. The topics are placed 

in logical order and often draw learnings from each other, alongside 

you must also refer to the spreadsheets that come along

Happy ‘Excel’-ling :-D
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Index
The INDEX function is the big daddy of the VLOOKUP function, How? Because 
of its powerful utility and faster processing. Let’s go check out this beast and 
mature our understanding step by step

Syntax
INDEX(array, row_num, [column_num])

Array is the range of cells where the lookup is to be  done
Row_num is the row number that you want to look up
Column_num is the column number that you want to look up

The Index function returns the intersection of the row and column number

Case
Lets say we want to find the record Ashley for the Month of Feb, which you 
can easily do it with a VLOOKUP formula but here is how the INDEX would do 
it

Now apart from simply being an alternative to VLOOKUP and returning the row 
and the column number

Column Number

Row
Number

James’s record is in
row 4 and col 3

Tricky Question? What if you wanted to do a total for James sales and not 
just return the sales of Feb ? Here the VLOOKUP would fail!

Now when you press enter the formula will give you ‘James’ as an output. The 
reason is that no excel formula is capable of giving multiple values as an 
output. But writing 0 in the column number fetches all the values in the row. 
Now all you need to do is wrap the INDEX around the SUM function

=SUM(INDEX(B3:G11,4,0))

Column number as 0 returns all the values in the 
Rows

This formula will give 
you the total sales for James

http://www.goodly.co.in/
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Match
In continuation to what we have learnt, let’s fuel our INDEX with MATCH 
formula. Let’s quickly get rid of some theory of MATCH function and jump on 2 
interesting examples

Syntax
MATCH(lookup_value, lookup_array, [match_type])

Lookup_value – What are you looking for ?
Lookup_array – Where are you looking (data range) ?
Match_Type – It has 3 options (Exact match or Match less than the lookup 
value or match greater than the lookup value)
We will stick to the exact match (denoted by 0) option for discussion as of now

YOU

YOU

Again, what is your 
position number 
starting from the Top ?

The answer 7 and 4 are no brainers, that is exactly what a match 
function does for you, it will return the position number of what you 
are looking for in a range of data and yes it can work horizontally or 
vertically :-D

Now lets make a big deal out of this no big deal MATCH function .. 
Ready?? Ok lets go ahead and solve 2 problems

• Using Index Match together 
• Lookup to the left ?

Can you tell, what is your 
position number starting from 
the Left ?Answer these questions

http://www.goodly.co.in/
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Index and Match together
Put both of them together an you have Superman ready !

Now the same example and we are trying to find the position of James

1

2

3

1. In this snapshot we are trying to find James. (lookup Value)
2. Trying to find James in the Range (lookup_array)
3. We want match to find the exact match

This will return the position of James i.e. 4

The Match formula feeds in the row
number for James and the column
number is 3. The result is 131

Self Work

Can you write a INDEX MACTH formula
to look for James and Apr

http://www.goodly.co.in/
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Lookup to the Left
Lets put our superman to work for looking up to the left of the data range

For some reason our unique employee id 
lies on the extreme right and we want to 
look for the designation of these 2 
Employee IDs ?

• EMPID0011
• EMPID0012

Lets first write a MATCH formula to find the position number of those 2 
employee IDs. Note that I have frozen the lookup range

Now add the INDEX function to make our superman work

Note that the INDEX is
only applied on the Designation

MATCH gives us the correct
row number of the Emp ID

http://www.goodly.co.in/
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Index – Advanced *

Hi, my name is
INDEX

Now think of INDEX like your intelligent secretary who is better 
than VLOOKUP. What I mean to say is that this secretary of yours 
(INDEX) has the capability of looking up at different data sets. So 
if INDEX wont find the lookup value in one data range it will go 
and find it another range

Let’s discover her (INDEX’s) capabilities, I mean work capabilities ;-D

Syntax
INDEX(reference, row_num, [column_num], [area_num])

Two things change here (reference and area number, so I’ll cover those 2 and 
rest remains the same
Reference – is the range of the multiple data sets
Area_num – is the number of the range where you want to search

Ok, so now 2 tables containing names, 
we want to either look up in table 1 or 
table 2

1

1. Reference – These are data ranges. 
Note that they are places in 
separate brackets and are 
separated by comma

* The index function has two syntaxes, for simplicity reasons we are denoting it as Index Advanced. You 
see both the syntaxes when you type =INDEX(

http://www.goodly.co.in/
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Index - Advanced
2. We enter our usual row and the column input. 

We have manually entered any row and 
the Column numbers as 4,2

This is where we will 
write our area number 
and reference it to our 
Index formula 

2

You can specify the area 
number in C20 and INDEX 
will pull up row 4th and 2nd

column from that area 
number3

3. The area number is the data range 
where you want to lookup. Not 
necessarily all data ranges that you 
specify should have same dimensions 
i.e. same number of rows and columns

http://www.goodly.co.in/
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Choose
I think life becomes great when we have the options to choose from. To make 
your formulas more versatile excel gives you a CHOOSE function. Lets take a 
look

Syntax
CHOOSE(index_num, value1, [value2], ...)

Index_num – This is your choice number
Value 1 – This is the value of the first choice
Value 2 – This is the value of the second choice and so on..

As you change the choice number in 
C12, the CHOOSE formula will pick up 
10%, 20% or 15% the values get picked 
up in the order of their occurrence in 
the formula

Choice 1 – 10%
Choice 2 - 20%
Choice 3 – 15%

Let’s play with the capabilities that we have acquired till now. Being INDEX 
MATCH and CHOOSE in your arsenal your secretary has now become a super 
woman.

Same case but a different question, you have to find the salary of ‘Greeko’ but 
you don’t know in which table has his record and you neither know his row 
number

You are not allowed to hard code formulas in the cell

Hints

• Index will allow you to select different 
areas (data ranges)

• Match will let you know the row number

• Choose give you a choice to select the 
table 1 or table 2

Self Work

http://www.goodly.co.in/
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Indirect
Let’s say we are making a journey, but we don’t know where are we going? .. 
I know it kind of sounds bizarre but I said that WE don’t know about our 
journey someone else knows, so we have to go to that someone and find out 
where we are going. I know I know it sounds like a big BS but hang in there

A100

This is ‘someone’ (Cell 
A1) and it is asking us 
to go to Cell A100

This is our Indirect 
function, going to 
‘someone’ which is 
cell address A1

Hi
Cell A100, has the text 
Hi

I know INDIRECT gives you a kind of feeling that where the hell am I going to 
use it ? But I will settle your woes in a while, as of now lets cover the syntax 
in a bit more structured way

Syntax
INDIRECT(ref_text, [a1])

Ref_Text – This is your cell address which leads you to another cell address
A1 – This is the way how Indirect will read the cell address. Let’s just stick to 
choosing TRUE as an option for now. This is an optional input & gives the 
TRUE value by default

Take a look

This is cell C6 and is asking 
the INDIRECT to go and 
fetch the value from cell N15. 
So the INDIRECT will return 
the value in N15

INDIRECT will return 
value in A100 i.e. Hi

http://www.goodly.co.in/


© Goodly www.goodly.co.in 13

Offset
Pure Monster! It has absolute killer utility but should be used with caution 
because of its volatile nature, we’ll discuss a bit on volatility later but as of 
now lets ride on OFFSET for a while

OFFSET function can start anywhere 
in your sheet and capture any set of 
data and give you options to sum, 
average any range and a whole bunch 
of other stuff

Syntax

OFFSET(reference, rows, cols, [height], [width])

Reference – This is your starting point in the sheet. Typically a cell address
Rows – No of rows you want to travel downwards/upwards from the start point
Cols – No of columns you want offset to travel left/right from the start point

We’ll discuss height and width (which are optional) in a while as of now let’s 
take a stock of what we got here!

Start from D14 then move up five rows (-5) 
and then move right one column (1) and 
OFFSET returns the value 200

Now lets say that you want to select the 
entire range of cells here and add them up

http://www.goodly.co.in/
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Offset Advanced
Just for simplicity reasons lets call this as Offset Advanced. Let’s look at our 
case where I want to add the range of data (100,800,300,200)

Just to reiterate Start at cell D14, then move 
five rows up (-5) and then don’t move any 
column (0), from here you want to select 4 
cells 

Now we specify
• Height as -2 (our range of cells is 2 rows 

upwards in height)
• Width as 2 (range of cells is 2 columns in 

width)
• Don’t press enter!!

Height

Width

OFFSET holds the array of cells in its mind and is not capable of displaying 
them in one single cell, secondly we have not specified anywhere that we want 
to take a sum of those value… OFFSET is so dumb!! I know .. but we’ll have to 
wrap OFFSET around a SUM function

Now the possibilities are limitless of how can you use this. I’ll discuss some of 
its advanced features a bit later. 
Please note that 

o Positive Row Numbers or Height – Travel Down that many rows 
o Negative Row Numbers or Height – Travel Up that many rows
o Positive Column Numbers or Width – Travel Right that many columns
o Negative Column Numbers or Width – Travel Left that many columns

http://www.goodly.co.in/
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Columns and Rows
They say simple things always make a killing utility, the saying goes true for 
COLUMNS and ROWS functions as well

Syntax
=COLUMNS(array) =ROWS(array)

Array – select a range of cells and it will specify how many columns or rows 
are there in that range

This will return 7, since 
there are seven 
columns in the range 
selected. Damn simple, 
isn't it ?

Rows formula will 
return the 
number of rows 
in the range 
selected i.e. 8

Lets make a killing by combining the VLOOKUP and the COLUMNS function

1. I have used the column function to 
count the number of columns to use 
in VLOOKUP

2. The column number in 
VLOOKUP is linked to the cell 
which has the column function

1

2

http://www.goodly.co.in/
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Address 
The simplest way to describe this function is that it returns the cell address of 
any cell. Let’s take a look

Syntax
ADDRESS(row_num, column_num, [abs_num], [a1], [sheet_text])

Row_num – The row number of the cell
Col_num – The column number of the cell. A is 1st column & B is 2nd and so on
Abs_num – This input is Optional. How would you like to reference the cell. 
There are 4 options here

• 1 stands for absolute referencing ($A$1)
• 2 stands for freezing the row (A$1)
• 3 stands for freezing the column ($A1)
• 4 stands for not freezing either row or column

A1 – Optional. Style of referencing, lets stick to A1 style (denoted by 1 or 
True)
Sheet_Text – Optional. This is the sheet name where you are addressing the 
cell. 

Lets say we are using the ADDRESS function on the cell A5 (outlined in 
picture)

1

2

5 and 1 denote the 
row and column 
number. 1 denotes 
absolute referencing

1 denotes the A1 
style referencing. 
We’ll stick to A1 style 
referencing to most 
part of our learning

When you press enter you’ll get the cell address $A$5. 
Now seriously, there is no big deal about this. Let’s get 
into a case where use the INDIRECT function with the 
ADDRESS Function

http://www.goodly.co.in/
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Indirect Function Application
Lets take a look at an interesting case. I have 3 sheets and some data on each 
of them

My job is to consolidate data on a single sheet. There could be many ways to 
do that (ranging from copying the data to linking each cell) but we are going 
to use the INDIRECT function

Note a couple of things
1. & operator is combining the sheet name with the cell address
2. Proper cell referencing is allowing to pick up data from multiple sheets
3. As of now we have manually written the sheet names and cell address but 

we can automate that too with ADDRESS function 

Ron Susan Pualine Daura

301 242 218 328

Ron Susan Pualine Daura

412 239 392 487

Sales of Jan in Sheet 1

Sales of Feb in Sheet 2

Sales of Mar in Sheet 3

I have written the sheet names here

The cell address is placed here 

The INDIRECT formula can 
pick up cell address from cells 
linked

http://www.goodly.co.in/
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Using Wildcards in Formulas
Just like the Joker in playing cards (which can fit anywhere) we have
wildcards in excel that do a similar job. Now these wild cards can be 
combined with excel functions like AVERAGEIF/IFS, COUNTIF/IFS, 
H&VLOOKUP, MATCH, SEARCH, SUMIF/IFS, etc..

Lets get going with an example. In the example below we have to total the 
CTC for all employees whose EMP codes are in 11 series (i.e. starting from 
11). Now if this data would have been a couple of thousand rows, it would 
truly have been a nightmare without the wildcard feature

We have here EMP ID and their CTC

Notice the * (asterisk) sign before and after 11. This 
simple SUMIF formula will give you the total CTC for 
EMP series 11

This will find all the records which have 11 in the EMPID

How the * Asterisk works: If the asterisk symbol is applied before a text 
string, it would match everything that ends with that text string. For example 
SUMIF(Range,”*ber”,Sum_Range) will include the sales for the last 4 months 
because they end with the string ber (September, October, November, 
December)

How the ? Question mark works : Unlike the asterisk, a question mark 
matches any single character For example, =COUNTIF(range, “sm?th”) will 
count all the smiths either with an I or Y (smith / smyth)

http://www.goodly.co.in/
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A quick recap - how date & time works in Excel
There is a special way how excel treats dates. For Excel, dates are nothing but 
numbers. To give you more insight, each date is a sequential number to excel 
for example my birthday 27-Apr-1986 is numbered as 31529. Now the obvious 
question is that, where did this number come from?

Let’s unravel this, The excel calendar begins on 1st Jan 1900 so that it is 
stored as the number 1 in Excel’s memory, 2nd Jan 1900 is stored as the 
number 2. Programmers have stretched the calendar till 31st-Dec-9999 (I am 
not sure if we are going to go that far in any sort of calculations, at-least I 
have not!)

A quick exercise - Can you find out the number of your birthdate ?

Just like dates, time is also a number but time being a smaller fraction (as 
compared to dates) they are presented as decimals. Let’s continue with my 
birthday, so the number is 31529

Take a look at how the time progress as I increase the decimals

1-Jan-1900
Starting date

31-Dec-9999
Last date

1  2    3   4    5………………………………………………………………………………………………………..2958465

DATES ARE NUMBERS IN EXCEL

Notice how the time changes when the 
decimal values are changing. If you 
increase the decimal places the time 
would reflect in minutes and seconds 
too!

http://www.goodly.co.in/
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Day, Month, Year
Now that you have an understanding that dates are nothing but numbers in 
excel. Lets take a look at 3 foundation building functions (DAY, MONTH, YEAR)

Syntax DAY function 
DAY(serial_number)
Serial_number – The date or the serial number

Simply put the DAY function will return the DAY of the month, for example if 
the date is 14 Feb 2014, DAY will return the number 14 (as the 14th day of 
the month)

Syntax MONTH function 
MONTH(serial_number)
Serial_number – The date or the serial number

The MONTH function will return the Month of the Year, for example if the date 
is 14 Feb 2014, MONTH will return the 2 (as 2nd month of the year)

Syntax YEAR function 
YEAR(serial_number)
Serial_number – The date or the serial number

The YEAR function will return the Year, for example if the date is 14 Feb 2014, 
YEAR will return the 2014 (as the year number)

Make no mistake in understanding, The 
DAY function is extracting the day of 
the month from a serial number(which 
is appearing to you as a date)

MONTH is returning the month 
number, starting from Jan as 1

Since all the dates are of 1997. The 
YEAR function returns 1997

http://www.goodly.co.in/
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Date
The date function in excel can combine the (DAY, MONTH AND YEAR) function 
and return the date. The previous 3 functions can disassemble a date and the 
DATE function can reassemble a date

Syntax
DATE(year, month, day) – They are pretty explanatory, so I’ll directly jump 
into an example

In our earlier example we used the DAY, MONTH and YEAR function. I am now 
adding a fourth column to combine the 3 separated elements (day, month, 
year) by the DATE function

Lets do a quick exercise to create a series of month starting dates. Take a 
closer look athe DATE function used. I have mannually input the year and the 
day and to get the correct month number I have used the ROWS function 
(with expanding range) by locking on the first part of the range

As you copy the formula down the 
range keeps expanding.

http://www.goodly.co.in/
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Second, Minute, Hour
Here we break down the date into even smaller elements (Second, Minute and 
Hour). Lets take a look

Syntax SECOND function 
SECOND(serial_number)
Serial number is again the date or a number

Syntax MINUTE function 
MINUTE(serial_number)

Syntax HOUR function
HOUR(serial_number)

The SECONDS function is 
extracting the seconds from the 
date and time, which otherwise 
would be a big formula alchemy

The MINUTE function is 
extracting the minutes from the 
date and time

The HOUR function is 
extracting the hours from the 
date and time

http://www.goodly.co.in/
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Time 
Just like the DATE function, the TIME function combines the 3 elements of 
time (Hour, minutes and seconds)

Syntax
TIME(hour, minute, second)

Here the TIME function is combining the smaller elements and giving the time

Ok let’s look at a similar function which combines the TIME and the Date 
together

Now
=NOW() returns the present date with time

http://www.goodly.co.in/
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Weekday and Weeknumber Functions
Excel has some built in functions that help you do different date related 
analysis like counting the day of the week or counting the week of the year, 
lets check out these

Syntax Weekday Function 
WEEKDAY(serial_number,[return_type])

Serial_number is the date or the number
Return_type this input determines on which day do you want to start and end 
the week

Weekday function returns numbers 1 to 7 denoting the day of the week. Let’s 
say I want to know which day of the week was 3rd May 1988. In the example 
below I select the date and choose the week starting number. Take a look at 
the drop down that pops up when I am inputting the return type. It gives you 
a lot of flexibility to choose when is your week is starting

Syntax Weeknum Function 
WEEKNUM(serial_number,[return_type])

Serial_number - is the date or the number
Return_type - this input determines the starting day of the week

This function returns the week number of the year. Continuing with 3rd May 
1988, the week number of this date is 19 (if we start the week on Monday)

Choosing 1 will set the 
week number starting 
from Sunday and ending 
on Saturday

Choosing 2 will set the 
starting day of the week 
as Monday

http://www.goodly.co.in/
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Time Stamp Problem
Now with some of functions under our belt let’s solve a typical problem at 
work. Lets say we need a time stamp against every data entered but the 
condition is that once the time is stamped against the data it cannot be 
changed. We would use a simple IF formula for this but with a new concept 
called Circular Referencing

Introducing Circular Referencing – One or more cell references in a 
circular formula circles back to itself. For example.. IF you type the following in 
Cell A10

=IF(A10<1000, A10+1, A10)

Each time we run the formula (pressing F9) the value in A10 will goes up by 1. 

Setting Iterations for Circular Formulas – Although the formula is made in 
such a way that it will increase the value by 1 each time but the number of 
iterations that are set in excel settings for circular formulas can change the 
result. 

Turning ON Iterative calculations - Office Button > Excel Options > Formulas > 
Check 

It is a Circular Formula

Check this Option

Circular loop stops after 100 iterations

Now that we have understood circular referencing, let’s make a circular 
referencing formula. Be sure to turn ON circular referencing

The IF Formula is checking IF
1. Cell B9 is empty if it is not Empty 

then it gives nothing
2. If not empty then it checks IF cell c9 

is empty (here the circular 
referencing starts)

3. If cell c9 is empty then it enters the 
current time and date using NOW 
function else gives the value of C9

http://www.goodly.co.in/
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Ceiling and Floor Functions
I think these 2 functions are incredibly simple and powerful

Syntax CEILING function
CEILING(number, significance)

Number – can be any number
Significance – is the multiple

I think I’ll make more sense with this example. Consider a set of numbers, In 
the formula I have specified the number and the significance as 3. Now this 
function will take the numbers and push them up to the next multiple of 3. For 
example if =CEILING(11,3) will result in 12, because the next multiple of 3 
after 11 is 12

If you have understood the CEILING function the FLOOR function is just a 
sitter for you. Just as the CEILING function pushes any number to the next 
multiple of the significance, the floor function pushes the number downwards, 
here is the syntax

Syntax FLOOR function
=FLOOR(number, significance)
Nothing much to explain in the syntax here, lets jump right into an example

Note the CEILING 
function is returning 
the next multiple of 3

For Example 
=CEILING(14,3) will 
result in 15

The FLOOR function here is returning 
the previous multiple of 3

For Example =FLOOR(14,3) will result in 12 
(which is the previous multiple of 3)

http://www.goodly.co.in/
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Even and Odd
A little less sophisticated are the cousins of CEILING & FLOOR i.e. EVEN and 
ODD functions

Syntax EVEN function
=EVEN(number)

Number could be any number

Just as the name suggests, the EVEN function returns the next even number 
to the number specified in the function

Syntax ODD function
=ODD(number)

Right opposite to that is ODD which returns the next odd number to the 
number specified in the function

Take a look, its pretty easy!

The EVEN function is returning 
the next even number to the 
number selected

The ODD function is returning 
the next odd number to the 
number selected

http://www.goodly.co.in/
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Finding out Quarters of Dates
Self work Exercise

Make a formula to find out quarters of the dates. For example 

• 02-Feb-2014 is the 1st Quarter 

• 15-Apr-2013 is the 2nd Quarter 

• 27-Aug-2010 is the 3rd Quarter

Finding Indian Quarters - See if you can tweak the formula a bit to find out 
Quarters for Indian financial year? That means that quarter 1 is from Apr -
June

http://www.goodly.co.in/
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Cell and Info Functions
These come handy when you want to know some information about a cell. 
Take a look the syntax

Syntax
=CELL(info_type, [reference])

Info_Type – It gives you a list of information that you can pick up from
Reference – Cell address for which you the information selected. This is 
optional if not specified the formula gives the information about the cell in 
which the formula is typed

The INFO Function is similar to cell function. Just type =INFO and select the 
information that you need

Choose the information type 
that you want to see and press 
Enter

Just pick the information that 
you need!

http://www.goodly.co.in/
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Ifna
IFNA function is similar to IFERROR function. The only difference is that it only 
checks for #N/A error

Syntax
IFNA(value, value_if_na)

Value – Could be a formula or reference to a cell that you are evaluating
Value_if_na – Is the value/number/formula/cell reference that you want in 
case the value returns a #NA error

In the case mentioned below IFNA will return N/A since the VLOOKUP range is 
empty, in that case the formula will return the text OK

Since the VLOOKUP range is empty it will return #N/A

IFNA will return the text ‘OK’

http://www.goodly.co.in/
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Clean and Trim
These two function come very handy when you have to clean your data. Lets 
take a dive

Syntax CLEAN function
CLEAN(Text)

Text could be any text

The clean function is used for removing all non printable characters from the 
next. Take a look at this case where each last name is appearing the next line. 
I have to remove all the ‘enters’ before the last name for which I can use the 
clean function

Syntax TRIM function
TRIM(Text)

The trim function removes all spaces from text except for a single space 
between words. You can use TRIM on text that you have received from 
another application that may have irregular spacing

The CLEAN function is cleaning all the 
unwanted (enters) before the last name

Notice the irregular spacing between the 
words in the text. The TRIM function is 
clearing all the spaces apart from a single 
space between the words

http://www.goodly.co.in/
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Rept
At the first glance this function will look like, am I really going to use this? But 
I’ll tell you one of the coolest trick with function. Let’s do this

Syntax
=REPT(text,num_times)

Text – is any text
Num_times – is the number of times you want to repeat that text

For example if you write =REPT(“a”,10) it will repeat ‘a’ ten times and return 
aaaaaaaaaa, now as promised let me show you something cool about this 
function. Lets say we have a set of sales numbers for which we want to make 
a chart

Self Work – Based on this I have a question for you 

How would you make a chart using the REPT function when the sales values are 
large, consider this example ?

I have used the REPT function to repeat a 
line “|” the number of times of sales and it 
somewhat looks like a compact chart.

http://www.goodly.co.in/
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2. Array Formulas

They are also know as CSE (CTRL+SHIFT+ENTER) formulas because of their 

conditional capability of only working by pressing Ctrl + Shift + Enter. This is 

one of the difficult topics in Excel so to make this topic fun and interesting 

we’ll take a look at various concepts in various examples discussed in this 

section
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Array Formulas
An array formula has an advanced capability of handling operations for not a 
single cell but a range of cells together.. Eh?? Confused? Forget that take a 
look a case here

Question : You have to find the total change (close price – open price) by 
writing one formula in a single cell?

We have close and open price information 
of 5 stocks

I am sure you can do that with that giant 
ugly formula. But could there be a better 
way?

Introducing Array Formulas: Now to do the same operation I am going to 
write simple and short (array) formula, which is going to be slightly different 
than how a normal formula would look like.. Ready?

Notice the following

1. Inside the SUM function I have selected the Close Price Range and Open 
Price Range 

2. The way it will work is, the formula will take the difference between each 
values in the 2 ranges and then sum it up

3. But I cannot run this formula by pressing ENTER, it will give me a #VALUE 
error, I have to use CTRL + SHIFT + ENTER to execute this formula

This formula will take the difference between 
each value of the 2 ranges and then sum it up. 
Please make sure to press CTRL SHIFT ENTER 
to execute this formula. A simple ENTER 
command will not work
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Array Formulas
Now the obvious question arises that how would you know if a formula is an 
array formula? 

Some ground rules of array formulas

1. Whenever you force an array into a formula argument that cannot by 
default handle an array, you turn the formula into an array formula

o In the case that we just discussed, although SUM function can handle 
a range of cell (or an array) but inherently it cannot perform any 
calculation with the array selected

2. Array formulas only work only by pressing CTRL + SHIFT + ENTER, without 
that either the formula gives you a wrong answer or an ERROR

Auditing array formulas

Undoubtedly array formulas can do the unthinkable in Excel and sometimes 
these formulas can become extremely lengthy and geeky. Just to get a hang 
of how the array formulas are working, you have got to know a way to audit 
them. As an example I would use our recently discussed =SUM array formula

To see how the formula is working

Notice that we are  first performing array 
calculation then wrapping that around the 
SUM function. The sum function does not 
support that so we use CTRL + SHIFT + 
ENTER to enforce that into an array 
formula

Select the range and press F9

It shows the values in the range

Select the second range and press 
F9. It would show the values for 
that range too

Select the two ranges together 
and press F9

It then shows up how each value 
of the range is picked up to give a 
difference

The when you press F9 on the 
entire SUM function, it finally 
gives you the answer 224
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Array Formulas
Observations from the example

1. Do not press enter mistakenly after you have evaluated a part of the 
formula by pressing F9. WHY? Because F9 is the calculation key and it 
would replace the cell references with absolute values in the formula after 
you press enter. So either press ESC key (to come out of formula cell edit 
mode) or press CTRL Z to undo the F9 key effect

2. Just as we saw in the example the F9 key can evaluate a part of the 
formula so you can technically break down the evaluation in bits and pieces 
and understand a formula

3. This F9 calculation feature is insanely beneficial when you are making some 
serious formula alchemy and you want to keep testing the results as you 
build up a giant formula monster

Boolean Logic in Array Formulas

Lets delve deeper and get more Geeky with Array Formulas. Let me pick up an 
example an introduce a new concept (that works as a backbone) in array 
formulas. We have stocks their Purchase Price and Market Price. We have to 
find the total Profit made on all the stocks but keeping the power of array 
formulas in mind, we got to do that with a single formula in one single cell

The Logic is that the stock would obviously be sold if the Purchase Price is 
less than the Market Price, else one would not sell the stock! Sounds Right?

The IF statement has 3 parts

1. We are checking if the Purchase 
Price range is less than the 
Market Price Range

2. If that condition is true I want 
the difference of the market 
price range and purchase price 
range 

3. Else 0
1 2 3
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Array Formulas
Evaluating the formula with the F9 key – How the Boolean Works

1. Select the first range in the IF Condition and press F9 – The first rang 
expands to show the purchase prices of different stocks

2. Select the second range in the IF Condition and press F9 – You will get the 
range of market prices

3. Select both the ranges in IF condition and press F9 – You will get TRUEs 
and FALSEs for purchase price being compared to market price. Where ever 
the condition is true it will display TRUE else FALSE

4. Select the next range for Value if TRUE and you will get the difference 
between the two ranges by pressing F9

5. Finally select the entire IF statement and press F9 - IF will pick Market 
Price – Purchase Price for only the TRUE Values

6. Now SUM will sum only the positive values (i.e. where you have made a 
profit)

These TRUES and FALSES are Booleans. For each True IF will 
pick up the difference between Market Price and Purchase 
Price and for each False IF will pick up 0

Check out the 0 (zeros) in between the values. Those are places 
where the IF condition was giving a FALSE

http://www.goodly.co.in/


© Goodly www.goodly.co.in 41

Array Formulas
As of now we have been talking about formulas that can be forced to operate 
and calculate arrays by pressing CTRL SHIFT ENTER but then there are also 
exclusive array formulas that just work with CTRL SHIFT ENTER not otherwise

Frequency Function
This function can calculate the frequency distribution between different 
intervals. 

Syntax
=FREQUENCY(data_array, bins_array)
data_array – The data from which we want to calculate frequencies
bins_array – These are intervals

Lets take a look at an example

This formula would require you to first select a range of cells where you want 
the result (one extra cell than the bins_array)

We have race time data for which we want to 
find how many values fall between the specified 
time intervals

Although we have written the intervals in this 
fashion but the Frequency formula would need a 
series of values

1. Select the cells (one more than the bins array
2. Select the data array and bins array
3. Use CTRL + SHIFT + ENTER to execute the 

formula
Note that Bins_array is always the upper limit. We 
select one additional cell while typing the formula 
because that gives us frequency more than the last 
value in the bins_array
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Array Formulas
Transpose Function
This function can turn horizontal data into vertical and vice-versa

Syntax
=Transpose(array)
Array is the range of cells that you want to transpose. Excel automatically 
converts a vertical array to horizontal and vice-versa.

Take a look at an example here

This can also be done with Paste Special but in that case the Data is pasted 
and there is no link between the two data sets, so in case your main data 
changes the changes will not reflect in the paste special transposed data

This is a vertical data

With TRANSPOSE formula we have converted that into a horizontal

1. Select the number of columns/rows needed to fit the data
2. Write the TRANSPOSE function and select the array
3. Press Ctrl + Shift + Enter to execute
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3. Excel Tables

Before we get started with this section, I want to write a prologue 

about its awesomeness. I have not seen this feature to be too familiar 

with the excel fraternity but this is very powerful for whole bunch of 

reasons. Lets take a sneak peak into what are we going to cover in 

this section

1. Excel Tables – What are they and how are they created ?

2. 8 reasons should you consider using excel tables !

3. Writing formulas in Excel Tables - Introducing structural 

referencing
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Excel Tables - getting started
What are Excel Tables ? 

An excel table is a structure given to a set of data in excel automatically when 
you access this feature. The structure includes
• A neat and prominent formatting of data
• The data is stored under the Table Name as Table1 or Table2 and so on, you 

can also customize the name of the table
• Because the data is stored under a unified table structure, excel does not 

see this as individual cell addresses but as Table1 or Table4 etc..

I am not going to make this boring.. So let’s take a look at some sales 
transaction data

Creating a Table ?

This data spreads from Column B to G and runs in about 600 rows. Lets 
convert this data into a table

1. Select any cell inside the data range and use the shortcut Ctrl+T
2. You’ll have a ‘Create Table’ dialogue box intuitively guessing the 

range of the data and asking if your data has headers
3. Go ahead and click OK. Note that headers should be present in the 

data range and should be ticked (in our case)

590 rows of 
such data

• Formatting 
has changed

• Filters 
appeared

• Alternate 
rows 
coloured

• Thin border 
outside the 
table
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Excel Table – What is so special about them
Here are my top 8 reasons to use table. Lets explore them

1. Quick Formatting – As soon as you convert the data range to a table 
structure you quickly format the table. Even you revert the table back to a 
normal data range the formatting stays

2. Effortless data entry – As soon as you enter a new row or column Excel 
picks up the new data in the table structure

3. Customize Output Options – This is awesome, You can change the 
operations (for sum, count, average etc) at the end of any column

4. Visible Headers – The table feature will always display the headers of the 
data, even if the screen is scrolled till the end of the table. In that case the 
column headers are replaced by the table headers

5. Auto Fill Formulas – Let’s say I am calculating the costs (Amount –
Profit) in our table, the table feature auto fills the rest of the rows by itself 
for a particular calculated column

Total column has filters to 
change the Operations (Sum, 
Count, Avg etc)

Also note that the headers are always 
visible. Here the column names have 
been replaced by the table headers
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Excel Table – What is so special about them
If you are wondering, how is the formula written. Is this range naming or 
something else? Let me tell you it is none of those but Structural references

6. Structural References – Lets decode structural references. In table the 
way you reference an entire column is by its header name, since you convert 
the entire data into a table structure, individual cells (or range of cells) lose 
significance

Lets say you want to calculate 30% tax on profit, the way it will work in tables 
is as follows. Start typing in the highlighted cell

=[Profit]*30%

As soon as you press enter excel will populate the answer in the cells in the 
Tax Column. This kind of referencing is called structured referencing

Please take a note of a few points to make better sense of structured 
referencing

1. Since there is no cell referencing (=A1) the table is referred by its structure 
or the headers for example =[sales]*[commission], this will take each row 
in the sales column and multiply it with each row in commission column

2. If you only type headers or column name (always in square [..] brackets), 
be sure to be working in the adjacent row or column of the table. Like we 
just did our tax calculation(which was an adjacent column to the table)

3. If you are referring the column header in some function or anywhere else  
in the sheet (which is not adjacent to the table) then you also have to 
specify the table name. Here is how you do it

=SUM(TableName[Sales]) this would total the sales column in the 
table name you specify
=Sales[Profit]*Tax[TaxRate] this would take each item row of Profit 
Column from the sales table and multiply it with TaxRate column in the 
Tax Table

4. Naming Tables – By default your tables are named as 
Table1 or Table2 (in the order you create them). But a 
better practice is to name the tables by clicking anywhere 
in the Table and from the Design tab, click in the Table 
Name field and type the new name for your Table

Table name 
field
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Excel Table – What is so special about them
7. How formulas work in Structural referencing  – Don’t be afraid it is 
pretty simple.. Simpler than you think :-D

Case
For instance we have two tables 

Named as 
SalesNamed as 

Cust

Our task: find the correct customer code from the customer table and put it 
against each customer in the sales table. Simple VLOOKUP, here is how we 
would do it!

Next Task: We have expanded the customer table and we have to find the 
total of each customer sales from the sales table

Take a note of couple of things
1. Since we have to pick up the criteria range from the sales table we have to 

specify the table name along with the column header i.e. Sales[Customer 
Name]

2. We are writing the formula in the ‘Cust’ table so no need of table name
3. The sum range is again picked from the sales table i.e. Sales[Amount]

[customer Name]
becomes the Lookup value 

Name

Cust
Table is the Table array
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Excel Table – What is so special about them
8. Dynamic Charts and Data Ranges – now such a beauty can be extended 
to charts and dynamic ranges in pivot tables as well. Consider the following 
data, where we have used a table to make a chart

The same concept can be applied to pivot tables as well. Let’s say we want to 
make a pivot table from Sales table

We just entered the table name in the Range field, now as and when new data 
is added to the sales table the Pivot table just needs to be refreshed and new 
data will be picked up in the Pivot Table automatically

When you enter July’s Sales the 
chart will self update
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4. Advanced Filter
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Advanced Filter in Excel
This is one of the most underrated features on the contrary it is of great utility 
and easy to use !! Lets pick up a case to get a hang of this 

Consider this data

The advanced filter is located in the DATA tab by the name ‘Advanced’ 
(Shortcut key – Alt A Q)

Make a separate place for writing the criteria on the sheet, let’s say on the top 
of our data. Include the headers too while writing the filter criteria, with the 
help of headers advanced filter will identify the which criteria will apply to 
which column of the data. So this is how we do it

Filter criteria for data 
• Sales Rep = Veronica
• Customer = MNTL

Criteria for Advanced 
Filter 
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Advanced Filter in Excel
Applying the Advanced Filter 
1. Go to the DATA tab and click on Advanced
2. Advanced Filter dialogue box pops up with 4 inputs

o List Range –> Select the entire data including the headers
o Criteria Range –> Select the criteria range (two rows including the 

headers)
o Click the Radio Button –> Copy to another location and click anywhere 

else on the sheet, where you want the filtered data to be copied
o Unique Records –> If you are looking for only unique records then 

check the unique records button
3. And you are done! Yes it is that simple :-D

Applying Diverse Filter Criteria - You can apply filter criteria in a diverse 
ways.. lets check outs some

Location where you 
want to copy

List

Filter
criteria

Filtered records for Veronica and MNTL and records for White Associates 
with Sales greater than >10000

1

2

Filtered records from 2-Jan-2005 till 31-Dec-2006 for Varsha

3

Filtered records between 2-Jan-2005 and 31-Dec-2006 for Customer MNTL and 
filtered records for Boston Consultants for Sales >10000 in the Region East
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Advanced Filter in Excel
Partial Filter Result - You can also retrieve partial information, for instance I 
want to apply the following filter

• Sales Rep = Swati
• Region East = East

And the filtered records should only come for Date and Sales for that just 
write the headers Date and Sales in the Copy to Location (on the sheet) Select 
those headers only in the advanced filter (copy to location) option The records 
will only populate the Date and Sales for Swati and East

Food for thought !

Have you thought of using Advanced filter with wild cards.
Give it a shot!

Filtered 
records only 
for Date and 
Sales

Criteria
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5. Advanced Cell and 

Range Naming
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Cell & Range Naming
This is very straight forward and is the foundation of what we are going to 
learn about dynamic range naming and integrating multiple ranges in a 
formula. Lets get done with this quickly. You have a list of employees for which 
you need to calculate 20% commission on annual CTC

1. Lets name the commission % cell. Select the cell and type the name in the 
Name box on top left corner. Be sure to press Enter after typing the name

2. Now write your formula to calculate commission using the cell name

Just like naming a singe cell you can name the entire range as well. Nothing 
too complicated, just select the entire range and type a name in the name box 
and then use them in your formula. Here is a snippet

You can start typing the name and 
excel will automatically pick up 
the reference

The entire range is named as 
Salary
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Cell & Range Naming
Cell Naming Rules that you need to keep in mind
• An Excel name can't contain space characters
• The first character of a name must be a letter, underscore (_) backslash (\). 

Remaining characters in the name can be letters, numbers, period, 
underscore characters

• Names can contain uppercase and lowercase letters, and Excel does not 
distinguish between them. For example, North and NORTH are treated as 
the same name.

• Names cannot be the same as a cell reference, such as A$35 or R2D2

Additional Naming Options 
1. To edit/delete/modify the names. Visit name manager by Ctrl + F3. Also 

can be accessed in the formula tab 
2. To auto complete the cell name or your function, use the Tab key 
3. To insert the name in your formula use F3 (this will display the list of all 

names in the workbook) 
4. Use the shortcut Ctrl + Shift + F3 to name a bunch of cell together. This is 

how it works

Lets say we have a range of values

1. Select the entire range 
including the variable

2. Use the shortcut CTRL + 
SHIFT + F3 and then tick left 
columns

3. All the cells with numbers will 
be named with the variable 
text values
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Now that we have covered all good to know stuff, lets have the real meat. So 
we have a situation where we need to automatically create a sales chart for 
the most recent quarter

So I need to start counting from the start and count till end and pick all the 
data in the last row.. Sounds right? We’ll pick the Offset formula from our 
arsenal

Note that this is not the correct place to write the formula. The formula will be 
written in the Name Box

If you have gotten till here understanding most of what we have discussed 
then you must be thinking that this can be done by Excel Tables (they are self 
expanding when new data is added) but my friend they just expand and pick 
up all the data in the table, but we need to only pick up on the most recent 
quarter and not all.

We are going to do this by creating a dynamic range (a named range which 
only pick up the most recent quarter) with a formula

Jack (the genius) will tell us how to do it

Formula Based Range Naming

Hi my 
name is 

Jack

Need to create a chart for 
the most recent quarter. So 
the logic goes like..
When ever new data is added 
please take that data and 
make a chart

1. The Offset starts at $B$7
2. Then counts the number 

of filled cells from the 
next cell. We have 
selected some blank cells 
in the range so that when 
we add new data that gets 
picked up automatically.

3. We then move to the next 
column by specifying 1

4. Width is set to 4 which 
will pick up the data in 
the next 4 columns

1 32 4
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Formula Based Range Naming

Copy the formula in the cell 
edit mode

Now go to the Name Manager (CTRL + F3) in formulas tab and click on the 
‘New’. A New Name dialogue box will appear

Now pick up the last of data and make a simple column chart

Enter a suitable name. Keeping in mind 
the cell naming rules!!

Paste your formula here

1. Right click on the chart 
and choose select data 
option

2. Then click on Edit in the 
left column

I have first written the sheet name 
and then written my named cell 
(which picks up the last row)

‘mapping sheet.xlsx’!Last_row
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Formula Based Range Naming

• As soon as I enter new 
data the chart updates 
itself

• But there is a slight 
problem! Could you 
figure that out?

Yeah that’s right the label of 
the chart is incorrect ! 
Because it is not dynamic as 
the data is. Can you make 
the label dynamic ?

Jack’s Dynamic Data Label Challenge!

Here are a few hints for you excel studs!

1. Create a formula that only picks up the quarter in the last row
2. Name a cell with that formula
3. Place it in the chart!!
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6. Form Controls
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Form Controls
Ever imagined talking to your spreadsheet report

You: Hi, Spreadsheet can you show the comparison between Co A and Co B and 
take off Co C from the chart

Spreadsheet: Sure sir.. <Some operations….axkj jhbkznkbhwih921u392u49> here 
you go.. This is the updated chart with only Co A and Co B information

You: Ok great, Now I want the top ten customers for Co A and Co B

Spreadsheet: <asldk289.amskjdf912342.0> here are the top 10 list of customers 
(with graphs) for Co A and Co B

The form controls feature let’s you do just that. Cool..eh? We can develop 
some self explanatory buttons and tools to get answers to questions like 
above and make our bosses happy… So let’s do this

Where are Form Controls ?

Form controls are placed in the Developer Tab. If you are unable to locate the 
Developer Tab you’ll probably have to turn it on

Turning on the Developer Tab Excel 2010 and 2013

1. Go to Excel Options in the FILE Tab
2. In the Excel Options Window go to Customize Ribbon in left panel 
3. And tick on ‘Developer’ option
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Form Controls
Turning on Developer Tab in Excel 2007

1. Visit the ‘Excel Options’ again by clicking the Microsoft Window button on 
the top left corner of the screen

2. The Popular Tab (left panel) will have option to turn on the Developer Tab

Inserting Form Controls

Click on the Insert button drop down in the Developer Tab 
for accessing a whole range of Form controls. As you can see 
there are two types of controls and both look similar, the 
other one being Active X Controls. We’ll talk about them 
once we finish discussing Form Controls

Let’s get started! There are 9 of them out there of which we 
will cover 6. Before I start naming each and help you 
understand how to use them, I just want to mention two 
critical aspects about Form Controls

1. Using Form Controls – Form controls are extremely easy and intuitive to 
use. For example if you see a scrollbar you don’t need an Einstein brain to 
figure out what to do with it.. Its simple.. Just scroll baby, just scroll up and 
down

2. Creating Form Controls – Now here is where you will require some 
geniuses because you need to connect that scrollbar to your data in excel 
so that when the user is using it, it populates correct data

Our learning will be focused on becoming
geniuses i.e. Creating Form Controls
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Form Controls
Creating Form Controls – Form controls are found in the Insert Tab drop 
down in the Developer Tab

You can pick any form control and cursor icon will change to a plus sign. 
Simply drag the plus sign on the sheet and Form Control will be drawn. No 
rocket science, its very intuitive!

Renaming Form Controls
Form Controls make no sense with their default names the. So you can right 
click on (any) form control and choose Edit Text option. When you are done 
editing the name simply press the Esc key. The form control naming has no 
effect on their working, its is just for the reference of the user

Format Control Options
This is where the real game lies. Each Form Control comes with different 
formatting options. In the coverage ahead we are mainly going to discuss only 
the formatting options of some very useful form controls

Here are the 
Form Controls

Click here to rename
the Form Control

To Open the formatting options
of any Form Control, click here
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Form Controls
1. Button

Looks and works like any button. So what would happen if you press the 
(on/off) button on your laptop.. Yeah right your laptop will turn ON or it will 
turn OFF? .. Getting smarter.. Huh?

Just as the way buttons work in real life.. They do something. The excel Form 
Control Button will also do something. Now that something comes from a 
Macro so as soon as you draw the Button control excel will populate an Assign 
Macro window to assign some Macro (that will do something) to that button 
you just created. When you press the button that macro will run

Here we are setting our bounds to some crazy out of the box stuff without 
using VBA

2. Combo Box

I am sure you are familiar with the List option in Data Validation which creates 
a drop down, the combo box is just a bit different. The format control gives 3 
design options to link this with the spread sheet

I know the above explanation is not enough, we need to be more practical 
here so lets do a case. You have a long list of Emp IDs and Grades, you need 
to make a combo box which selects one ID and based on that it shows the 
grade of the employee

Range to be shown in drop down list

The cell (any cell) which is to be 
linked to the spreadsheet
• If you select the first Item …any 

item (text or num) from the list, 
the cell linked will show number 1

• If you select second item it will 
show number 2 and so on

When you drop 
down the list how 
many items you 
want to show. 
The rest can be 
scrolled

40+ records

Step 1) Insert a Combo Box, close to 
the data on the sheet. That is simple!!
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Form Controls
Step 2) Open the format controls of the combo box inserted and select the 
data from the sheet, link it to cell in the sheet and specify the drop down lines

Step 3) Now when you click the combo box dropdown it will show the list 
drop down of the EMP IDs we just need to connect the drop down to a formula 
that fetches the correct grade for that ID.. Which is our regular INDEX or a 
VLOOKUP (you are already a pro at it)

Range of employee IDs

A cell linked to sheet, which will 
change as the user selects the 
value from the drop down

No of items that 
will be displayed 
in the drop down, 
rest can be 
scrolled

When list item is 
picked, the number 
of the list item gets 
displayed in the cell

A simple index 
formula to get the 
desired Grade for 
the Emp ID selected

We’ll this could have been done without the combo box as well.. but at times 
combo box serves as a great utility in dashboards and automation reports!
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Form Controls
3. Spin Button 

They are pretty simple to construct, but they can only be constructed like a 
portrait. By looking at spin button you can realize that it is meant to increase 
or decrease a particular value

Let’s create a spin button and open the Format Control box

Since we specified the current value as 1, we start from 1 and increment by 2 
till we reach 100 (3,5,7,9 and so on..) each time you click the up button

Current Value displayed at start
Minimum Value
Maximum Value
Increment when you click the button

Address of the linked cell

4. Option Button

Option button are meant to give the user the flexibility of choosing an option 
between some. You can insert as many option button on a single sheet and 
link them all to a single cell. Lets insert 4 option buttons on the sheet and 
work with them

The format Control box gives us the only option to link each of the Option 
button to a single cell in the sheet

Apart from inserting 4 option buttons 
I have also renamed them by right 
clicking and choosing Edit Text option

Let’s format them each!

Address of the linked cell
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Form Controls
When you change the value of the Option Button the value updates in the 
linked cell

You can use them in various scenario analysis

4. List Box

The list box can hold a list of values (some) visible at a time (if your list is 
large) and lets the user choose any one of the list item. Depending the 
number of the item chosen (from top to bottom) it will give its sequence 
number. Lets explore this as well

Here is how we format this

5. Check Box

The check box lets you check and uncheck the button and return a 
TRUE/FALSE Boolean where TRUE means 1 and FALSE means 0. The format 
controls of the Check Box looks like this

Note that the linked cell picks up the value as per the 
order of options button inserted.. So the option button 
inserted first will by default have the number 1 and so n. 
The cell value has nothing to do with the text that you 
enter to name the option button

Although the format control 
gives us the option to select 
multiple values from the list, 
but alas! multiple values cant 
be executed without a VBA 
Code (macro)

Only gives you the option to link to a cell 
address. When you check the check box it 
returns TRUE, when unchecked it returns 
FALSE
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Form Controls
6. Scroll Bar

The scroll bar scrolls a particular value up or down. You can insert the scroll 
bar horizontally or vertically. Lets first get the format control basic right and 
then delve into an interesting case

The value appears as per the scroller’s 
position in the bar

Change in value when 
you click in between 
the scroll bar

Change in value 
when you click the 
corner arrows

Linked cell in the 
sheet

Case – Making a scrollable list!!
Lets say that we have a long list of Employee Names and their Cost to 
Company

Step 1) Create a vertical scroll bar and link it to a cell in the sheet

150 records

1. Minimum value has been set 
to 0

2. Maximum value has been set 
to 140

3. And linked a cell in the sheet

The reason why have we 
specified mini value as 0 and max 
value as 140 will be clear to you 
in a while!!

3

1
2
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Form Controls
Step 2) Add row numbers next to the scroll bar. Use the =ROWS function with 
an expanding array (freeze only the first part of the range)

Step 3) Write a simple INDEX formula to pull the records from the table. Lets 
see how the INDEX formula is working

• It is taking the array on the data range specified
• The row number is deriving from the ROWS function used and we are 

adding the value in the cell linked to the scroll bar.
o WHY ? Because when you scroll down.. The value will change (2,3,4, 

and so on) the new value will then be added to the ROWS function 
that is being fed into the INDEX… phew!! Too much is it??

• The column number is 1 for the Names and should change to 2 (manually) 
when to copy the formula right to fetch the CTCs

This trick is incredibly helpful in dashboards, you can further compact the 
formula by consolidating the logic in a single formula and may be using the 
MATCH function to fetch the column numbers

2 3 41
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Pivot Tables
In my opinion Pivot Table’s usage has been mixed. Some live and sleep with it 
and some shy away. I am going to discuss some basic stuff and more of 
unconventional advanced stuff in this topics. Let’s see if I can spurt your love 
for pivot tables ?

Let’s roll some unique features with a case (data)

Exploring the Grouping Feature
We want to summarise the data region wise by quarterly sales. So we draw a 
quick pivot table on the data and it looks like this

~600 such 
records

A pivot table with Region in 
columns and Date in Rows 
looks like this

But this kind of pivot table wont be of much help since the dates are not 
showing in quarters and years. So Let’s group them
1. Right click on the dates in the pivot table data and choose Group
2. Then Group it with quarters and years
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Pivot Tables
Once you have done the grouping the data will show something like this. 
Beautiful.. Just as we wanted!

Problems associated with Grouping

This was cool, lets check out some problems that you might face with 
grouping. Lets create another pivot table on a different sheet with the same 
data and try and group the dates into months and years this time

Just as this 
you can do 
grouping in 
multiple ways

Just for saving space I have 
skipped inserting the regions in 
the columns

Notice 2 things

1. Since you had grouped the 
earlier pivot with Years and 
quarter a new year field 
starts to appear

2. If you change the grouping by 
months the earlier pivot also 
changes.. That is not what we 
want
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Pivot Tables
The solution is to separate the grouping for each pivot table, so we are going 
to go back in 2003 and take the solution from there. Old is gold!! Lets create a 
pivot table like the way it was done in version 2003. The shortcut was ALT D 
P. It will pop with the 3 stage process

1. Click Next, make sure that 
the options selected here 
match with your working

2. It will self select the 
data and show you the 
range, Click Next

3. Now this dialogue box is important. If you read the message it says you’ll save 
memory if you choose to keep the same grouping as the other pivot table but 
that is exactly that we don’t want to do.. So choose NO

After you are done with this process you can freely group the dates in a 
different date structure

http://www.goodly.co.in/


© Goodly www.goodly.co.in 73

Pivot Tables
The grouping feature also can split the data in class intervals. Take a look at 
this case

Names and age of 
about 600 people

We want to find the number of people 
in the following categories
• 20-24
• 25-29
• 30-34
• 35-40

We have dropped the Age in the rows and 
Name in Columns (that will give the count of 
name

In the grouping dialogue box we simply 
define the start and end age brackets 
and specify the class interval to be 5

And we get the desired result

http://www.goodly.co.in/


© Goodly www.goodly.co.in 74

Pivot Tables
The problem occurs when the data (numbers) are in decimal units

Tweaked the data 
a bit with Names 
and Wage/Hour

We want to find the number of people 
in the following wage categories
• 20-24
• 25-29
• 30-34
• 35-39
• 40-44

We follow the same pattern to add Age to Rows Field and Name to the Values 
field in the pivot table

Take a look at the class intervals and answer the 
following question

In which category the value 30 will belong ?
• Category 2
• Category 3

When the grouping feature in pivot tables are dealing with decimal numbers 
the categories are created in continuous forms but our question is still 
unanswered. In this kind of grouping lower limit is included and upper limits is 
not included in category. So the value 30 will belong to category 3

Slicers and Timelines in Pivot Tables
If you have not been a serial user of excel 2010 and pivot tables then Slicers 
will send you a tingle.. Ready for the tingle?

If I have to explain slicers, I would say they are better looking filters that can 
be applied on pivot table reports. Consider this Pivot Table report of our initial 
data with date as years in columns and customers in rows
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Pivot Tables
Find slicer option the Insert Tab. As soon as you click on slicer excel will throw 
a dialogue box asking on which field do you want to apply slicers?

This is a slicer, found in the Insert Tab

Excel inserts a neat looking 
option box (slicer) where you 
can choose between 
different regions

Got the tingle? Now let’s explore Timelines (to enhance the tingle) along with 
slicer on the same data. Just next to slicer you will find the option for inserting 
timelines. Could not see it ? Hmm

Timelines (enhanced tingle) is available in Excel 2013 only.. So 
upgrade!!

Nevertheless, check out its awesomeness

Timelines in Insert Tab of Excel 2013
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Pivot Tables
Check out the timelines are inserted on Dates. You can select partial period to 
display adequate data. You can also change the unit of the date from months 
to quarters to even days

One of the issues that you may face with Slicers and Timelines is that you may 
want to attach a single slicer to many pivot tables or vice versa, here is how 
you do that

1. Select the slicer that you want to connect or disconnect and go Options Tab 
(only highlights when you select the slicer)

2. Click on Report Connections
3. In the dialogue box pick up the pivot tables where you want to link the 

slicer

Timelines can be adjusted to select 
relevant time period.. And look 
equally awesome!!

So I have two pivot 
tables from the same 
data and a single slicer 
should work on both 
pivot tables

Pick up the pivot tables you want to link 
on unlink to the slicer here
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Pivot Tables
Now that we have looked at some unique features of Pivot Tables lets grab 
some calculations too

Running Totals
Let’s say we have grouped the dates by month and years and calculated sales

Right click on the sales and select 

Running Total
Jan (214100)
Jan + Feb (214100 + 122500)
Jan + Feb + March (214100 + 122500 + 196450)
And so on.. For all years

This is what we want!

Choose this option

Then select the running total on Dates
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Pivot Tables
Then select the running total on dates and your sales column will be replaced 
by running total grouped by years. Just add sales again to your value field to 
have two columns – one for running total and the other for sales

Just as running total we also have difference from calculation, lets check 
that out. I have restored the earlier monthly sales and now we want to take 
the difference from the last month

Sales column

Running Total (column 
name has been renamed)

Difference From Last 
Month
0
154900
-30800
83400
-154700
212850
-145750
8100

The additional column is telling us if 
the sales have increased or decreased 
from the last month
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Pivot Tables
Right click on the sales and choose  Show Values as  Difference from 
option  click on Previous in the dialogue box  OK

You might want to check out some other interesting options like
• Ranking of the data 
• % Difference from (to calculate the % change)
• % Running total (to calculate % additions)
• Many more useful operations depending on your needs

Be sure to choose 
previous for calculating 
the difference from the 
previous month

Here is the result.. Pure 
awesomeness
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Pivot Table – Data Models
Finally we now come to a bird called Data Model in Pivot Table. This bird is 
found in excel 2013 and beats the shit out data analysis.. Guys here is 
DATA MODEL

Jokes apart, data model feature really takes the analysis capabilities of pivot 
table to another level. Lets begin with an example

We have our old 
Sales Data with 
Customer Code 
this time

Customer data, with 12 unique 
customer names. These are the 
same customers that appear in 
the sales table with Customer 
code and an association date

Now convert the data in Excel Tables (refer to the tables reading) by pressing 
Ctrl + T 
• Name the Sales table as mysales
• Name the Customer table as Customers

Make a pivot table from the sales data and be sure to check the data model in 
the Pivot Table dialogue box

Be sure to check the Data Model option 
before you click OK
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Pivot Table – Data Models
Let’s keep some the data model aside for a while and lets get our head around 
a couple of concepts

Primary Key – Sound like you have heard it ?? It is the genesis of forming 
data relationships. Anything item which is unique and exists in a set of data is 
a primary key. Could you guess what is the primary key in our sales data ?

Ok how about the customer data, what is the primary key here ?

Foreign Key – would be the repeated records in table which can be uniquely 
identified by records in another table.. Eh?? Ok ok sorry for the weird 
definition take a look at the example.

Customer Code in Sales Table is a Foreign Key, WHY ? because the records are 
repetitive but if I want to bring together all the transaction of a particular 
customer code together I have a customer table with unique customer code 
that matches with the customer codes (multiple entries) in the sales table!! I 
hope you got it this time.. NO?? Read again, slowly, you’ll get it

If you have guessed 
correctly, there is 
no primary key in our 
sales data, since no 
unique field exists

The primary key here is the 
customer code. If you are 
thinking the primary key to be 
Customer Name, which is wrong 
because in the real world the 
customer names can be same (but 
as of now they are not repeating)

Customer Code in mysales table is the foreign key that can be identified uniquely 
with the Customer code in customers table 
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Pivot Table – Data Models
Coming back to our pivot table. Take a look at the pivot table field list, Mysales 
table has been added. Note a few visual and conceptual difference
1. A little table symbol in front of MySales – displaying column headers in it
2. A separate tab for Active tables and All tables

Two tabs for Active Tables and All 
Tables

MySales table added to the pivot table 
Field List

Right Click and take the customers to 
the Active Tab for further analysis

Now establish the relationships that we have just learnt

The Relationships exist in the Analyse Tab. 
Click and establish a new relationship

• Customer Code in Customers table is the Primary key
• Customer Code in MySales table is the foreign key
• Click Ok
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Pivot Table – Data Models
Now that we done set up the field for our analysis lets make a pivot table 
report. Notice a couple of interesting things going around here..!!

This way you can do multiple tables and link them in a single pivot table. Just 
a couple of things before I close on Pivot Tables

• Identical data type in both columns: Columns that you are connecting in 
both tables should have same data type (i.e. both numbers or dates or text 
etc.)

• One to one or One to many relationships only: Data Model works with 
only one to many or one to one relationships. That means one of the tables 
must have no duplicate values on the column you are linking to

• You have two tables MySales and Customers and 
their columns to choose from

• I have taken Customer (name) from the Customers 
table and Region and Sales values from the 
MySales table and make a pivot out of it

Now this is really something incredible.. No 
VLOOKUP stuff to get the customer name and then 
make a pivot, I deserve a treat here.. Don’t I?
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Custom Formatting and Applications
This feature allow you the change the way how your data appears.. Something 
like before and after make up transformation

But just as the old and wise say.. Make up does not change who you really 
are! So does it apply to custom formatting, it does not change the underlying 
data but only changes how it looks (and this is really important to remember)

Custom Formatting Basics – Structure and Logic

Custom formatting is applied by writing a code in the Format Cells dialogue 
box (shortcut Ctrl +1) in the custom formatting section
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Custom Formatting and Applications
We’ll discuss how to make a code in while but let’s discuss some ground rules 
first!!

Thumb Rule 1) The custom formatting code can consist of 4 parts

1. The Positive Numbers (1, 4, 100, 5000 etc)
2. The Negative Numbers (-1, -5, -10, -1000 etc)
3. Zero (0)
4. Text (Hi dude, Million, Days etc)

You don’t necessarily need to write the code for all 4 parts. Excel will assume 
the following in case you choose to omit one or more parts of the code

1. If you writing only the first part – then it applies to all numbers (+ve, -
ve and zeros)

2. Writing only first and second part – then first part formats +ve 
numbers and zeros and second part formats the -ve numbers

3. Three parts – 1st formats the +ve numbers, 2nd formats the -ve 
numbers, 3rd formats the zeros

Thumb Rule 2) You have to follow the sequence while writing the code. I 
mean you cannot write the code for a text first and then for a negative 
number… it wont work!! So the sequence for all 4 parts of the code will be  
Positive Number Code ; Negative Number Code ; Zero Code ; Text Code

Thumb Rule 3) Always separate the parts of codes with a semicolon. 
Remember the separator is a semicolon (;) not a comma. Simple right?

Thumb Rule 4) Put the text in the code in double quotes, example “Mn”

Writing a Short Code – Case

Your boss asks you to format it this way

1. Stacey (even if you are not Stacey :-D ), all the positive sales/profit 
numbers should appear this way – $ 173.0 Mn

2. All negative numbers should appear this way in red color - $ (14.0) Mn
3. All zeros should be replaced with a hyphen -

Consider this 
Sale/Profit data 
over 6 months
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According to the rules our code will follow this sequence
positive number code ; negative number code  ; zero code

1. Select your data (numbers only)
2. Go to cell formatting (Ctrl+1) and click custom and start writing the code 

(by replacing ‘General’)
3. Code for positive numbers for excel to format any profit/sales number in 

one decimal prefixed with a $ sign and suffixed with a Mn, we need a 
variable for sales/profit number.

0 is a variable for any number. So we will write $ 0.0 “Mn”;

Code for negative numbers Now negative number need to be in red and in 
brackets, rest is the same as positive number coding

Thumb Rule 5) When applying color to any part of the code, make sure the 
color is written first in square brackets [Red]

So our revised code looks like - $ 0.0 “Mn”;[Red] $ (0.0) “Mn”;

Finally Code for zeros We don’t need to see zeros, instead we want a hyphen 
or a dash so our revised quote looks like $ 0.0 “Mn”;[Red] $ (0.0) “Mn”;-

Note: code is separated with semicolon. Press Ok and see the result

Characters used in Coding and their function

Custom Formatting and Applications

” “ Displays any text between the double quotes

\ Displays the next character as it is

@ Character for displaying any text

* Repeats the preceding character to fill the width of the cell

#
Displays only significant digits and does not display insignificant zero’s, for example it 
won’t display 0001 rather will display 1

0
Displays both significant (non zero numbers) and insignificant zero’s, for example the 
code 000 will display 001,002 and so on

.
Decimal separator shows the number of decimal places after the number, for 
example 0.0 will show insignificant zeros and 0.# will only significant decimal places

,
Comma if suffixed after # or a 0 it divides the number by 1000, for example 0, “k” will 
result the number (15000) in 15 k

%
The percentage (%) symbol multiplies the number by 100 and suffixes the number with 
a % symbol, for example #.0% will result in 12.0%
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Custom Formatting and Applications

d Shows the number of the day

dd Shows the number of the day in 2 digit places. For example 07, 09, 15

ddd Shows the day in words. For example Sun, Mon, Tue

dddd Shows the day as unabbreviated. For example Monday, Tuesday, Friday

m Shows the month number from 1-12

mm Shows the month number in 2 digits for example 01, 02, 10

mmm Shows the month as a short word, example Jan, Feb, Mar

mmmm Shows the month as a complete word, example March, April, September

yy
Show the last digits of the year, for example 2014 will be shown as 14 and 2000 as 
00

yyyy Shows all four digits of the year

h Shows the hour

hh Shows the hour in a 2 digit number example 02 or 09

[h] Shows the total hours, for example a number (2) formatted as [h] will show 48

m
Shows the minutes. Note it only shows minutes if used as time formatting code (hh 
mm ss) otherwise it shows single digit months

mm
Shows minutes as a two digit number. Note it only shows minutes if used as time 
formatting code (hh:mm:ss) otherwise it shows single digit months

[m]
Shows the total minutes, for example a number (2) formatted as [m] will show 
2880

S Shows seconds

ss Shows the seconds in a 2 digit number example 02 or 59

[s]
Shows the total seconds, for example a number (2) formatted as [s] will show 
172800

am/pm Adds am/pm after the time as per 12 hour clock

Date & Time Characters and their utility
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Custom Formatting and Applications
Adding Conditions to your custom formatting code !

This is a real game changer and alters some of the thumb rules that have 
been with us this far. In custom formatting you can also apply conditions
if the number is > than 100 then color is red else color is blue

The new rules!

1. The conditions are written in square brackets [condition]
2. If any color needs to be applied with a condition then colors will come first 

in the code. For example [red] [condition]
3. The sequence of the condition is important – Excel stops reading the code 

further if the condition is met
4. Semicolon (;) is used to separate conditions
5. You can write 3 conditions at max

Consider this Code

[>=1000000] 0.0#,, “m”;[>=1000] 0.0#, “k”;0

1. Notice the semicolons. 2 semicolons for separating 3 conditions
2. 1st Condition (in square bracket) is checking if the number is more or equal 

to 1000000. If this condition is met then format the number as 1.0 m
3. 2nd Condition is checking if the number is greater or equal to 1000 then 

format the number as 1.0 k
4. 3rd Condition is checking if the number is not meeting any of the above 

conditions just write the number

This is how the code will format the following numbers

Number Custom Format

5293925 5.29 m

4761090 4.76 m

874911 874.91 k

390410 390.41 k

5246138 5.25 m

4514427 4.51 m

1785909 1.79 m

2802888 2.8 m
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Custom Formatting and Applications
Fractions in Custom Formatting 

Number in 

the Cell

Custom 

Formatting Code
Result

2.235 ?/??? 447/200

2.25 # ?/? 2 1/4

2.235294 # ?/?? 2 4/17

2.235 # ?/??? 2 47/200

2 # ?/2 2

2.333333 # ?/3 2 1/3

2.25 # ?/4 2 1/4

2.25 # ?/8 2 2/8

2.2 # ?/10 2 2/10
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Sheet Protection
If you want to prevent the user from accidentally or deliberately editing or 
deleting important data (cells) from your worksheet, you can protect certain 
or all cells, with or without a password

Lets say we have Loan Rate, Amount and Interest (Calculated) in a sheet and 
you wan that the user should not be able to edit the formula in the Interest 
calculation. This is how you would do it

1. Select the interest cell
2. Go to format cells dialogue box
3. And uncheck locked (by default all cells are locked)

1

2

3

1. In the Review Tab
2. Click on Protect Sheet
3. And if you wish you can specify a 

password. The user would need the 
password to edit

4. OK

Note that without protecting the sheet, cell 
locking is useless

1

2

3

3

The users are just allowed to perform the 
following if the sheet is protected. 
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Password Protect Different Ranges
You can also protect different ranges with different passwords. It’s called Allow 
Users to Edit Ranges and found in the Review tab

Lets say we have 4 regions where each region will have a different user enter 
the data

1. In Review tab in 
the Changes group > Click 
on Allow Users to Edit 
Ranges button

2. Click on ‘New’ to set up your 
first range for North, which 
will be cells C3:C14 and enter 
your password

3. Repeat for regions South, East 
and West using different 
passwords for each

Note the Following
1. Upon the user entering their password, 

that range becomes unlocked while the 
other ranges remain locked.

2. You can unlock multiple ranges and 
doing so will not lock any previously 
unlocked ranges.

3. Once a range has been unlocked by a 
user, it will remain unlocked until the 
workbook is closed.

4. Saving a workbook doesn’t lock any 
ranges.

5. No protection is actually applied until 
you password protect the workbook. 
Don’t forget this step

4. Now you should have all 4 
ranges listed in the Allow 
Users to Edit Ranges 
dialog box 

5. Click on the Protect 
Sheet button and enter a 
unique password (this is 
your master password so it 
should be different from 
the passwords for the 
users)

6. Now when anyone 
attempts to enter data 
into the protected cells 
they’ll be prompted for 
their password
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www.goodly.co.in 

Thank you for reading…

I hope you enjoyed reading this e-book!

Let me know if you have any questions or even if you would like to drop in 

a “hi”, I am active on goodly.wordpress@gmail.com

Hey, feel free to send this e-book over to your folks / excel nerds

Apart from delivering live training sessions for companies, I also run online 

training courses on Mastering Excel and Business Intelligence Dashboards. 

If you want to acquire top notch excel skills you much check them out

Cheers & stay tuned to Goodly

Chandeep
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